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1 About

1.1 This Manual

This manual enables safe and efficient handling of the device.

This manual is an integral part of the device, and must be kept in close proximity to the
device where it is permanently accessible to personnel. In addition, instructions concerning
labor protection laws, operator regulations tools and supplies must be available and
adhered to.

Before starting any work, personnel must read the manual thoroughly and
understood its contents. Compliance with all specified safety and operating instructions,
as well as local accident prevention regulations, are vital to ensure safe operation.

The figures shown in this manual are designed to be general and informative and may not
represent the specific Bruker model, component or software/firmware version you are
working with. Options and accessories may or may not be illustrated in each figure.

1.2 Policy Statement

It is the policy of Bruker to improve products as new techniques and components become
available. Bruker reserves the right to change specifications at any time.

Every effort has been made to avoid errors in text and figure presentation in this
publication. In order to produce useful and appropriate documentation, we welcome your
comments on this publication. Support engineers are advised to regularly check with
Bruker for updated information.

Bruker is committed to providing customers with inventive, high quality products and
services that are environmentally sound.

1.3 Symbols and Conventions

Safety instructions in this manual are marked with symbols. The safety instructions are
introduced using indicative words which express the extent of the hazard.

In order to avoid accidents, personal injury or damage to property, always observe safety
instructions and proceed with care.

A DANGER

DANGER indicates a hazardous situation which, if not avoided, will
A result in death or serious injury.
This is the consequence of not following the warning.

P This is the safety condition.

1. This is the safety instruction.




WARNING indicates a hazardous situation, which, if not avoided, could

A result in death or serious injury.

This is the consequence of not following the warning.
P This is the safety condition.
1. This is the safety instruction.

/\ cAUTION
T CAUTION indicates a hazardous situation, which, if not avoided, may

result in minor or moderate injury.
This is the consequence of not following the warning.
P This is the safety condition.

1. This is the safety instruction.

NOTICE indicates a property damage message.
This is the consequence of not following the notice.

P This is a safety condition.
1. This is a safety instruction.

This symbol highlights useful tips and recommendations as well as
information designed to ensure efficient and smooth operation.




2 Safety

This manual contains notices which should be observed to ensure your own personal
safety as well as to protect the spectrometer and the connected equipment.

2.1 Intended Use

The minispec is a pulsed time-domain NMR analyzer used for the monitoring of NMR-
receptive nuclei, particularly Hydrogen, Fluorine and Phosphorus, but sometimes other
nuclei.

This product is intended to be used solely for measurements on industrial samples. The
minispec and the minispec ProFiler have not been tested for compliance with regulatory
agencies for human subject exposure to radio frequency irradiation. Although no indication
that any danger exists, under no circumstance is this product intended for measurements
on humans.

2.2 Qualified Personnel

The minispec may only be set up and operated in conjunction with the instructions this
manual. Only qualified personnel should be allowed to work on this equipment. The
primary installation, maintenance and repair of the minispec may only be carried out by
personnel which are authorized by BRUKER.

All repairs, adjustments and alignments performed on any components of the minispec
must be carried out strictly in accordance with the established safety practices and
standards of the country where the instrument is installed.

2.3 Correct Usage

This device and its components may only be used in the way discussed with a BRUKER
specialist and in connection with devices or components from other manufacturers which
have been approved or recommended by BRUKER.

Note: This product can only function correctly and safely if it is transported, stored, set up
and installed correctly, and operated and maintained as recommended by BRUKER.
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24 Electrical Safety

There is no danger of electrical shock during routine operation of the spectrometer,
however the following precautions must be followed to assure user safety and protect the
instrument.

Electrical hazard from electrical shock
A life threatening shock may result when maintenance is performed.

1. Place the mains power switch in the OFF position (direction labeled "0" on the
Zﬁs switch).

2. Disconnect the device from the electrical power supply before maintenance. Use
a voltmeter to verify that the device is not under power!

3. Be sure that the power supply cannot be reconnected without notice.
4. Ensure that all warning labels are in place.

5. Only trained personnel should carry out maintenance.

The safety precautions applicable to any electronic device connected to AC power must

be observed.
n Always use the power cable that is delivered with the product.

If replacement of the power cable is necessary, make sure that the ratings with regard to
the power consumption of the device are suitable.

Electrical hazard from stored electrical charge

A life threatening shock or material damage may result from a stored electrical
charge.

» Never touch electrical contacts or semiconductor chips with any object
A (conductive or non-conductive) unless all of the following conditions are met:

1. The power switch is off.

2. The power plug is disconnected from either the power socket or the main power
socket on the spectrometer.

3. The conductive object and you are grounded.

= This precaution prevents the possibility of electrical shock from stored charge
within the power supply circuitry or the transfer of static charge that can damage
semiconductor chips.

power off) without first contacting a Bruker service representative to obtain all necessary

n Note: No other components within the spectrometer should be touched (even with the
instructions, to ensure user and spectrometer safety.
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2.5 Lifting Safety

The standard magnet unit may weigh up to 150 kg depending on the type, to ensure safety
the follow safety instructions must be followed:

/\ cAUTION

Risk of injury from lifting heavy objects.
The unit is very heavy and may lead to injury when lifting.
& 1. Do not attempt to lift the unit over the edge of the carton, remove the carton first.
2. Do not attempt to lift the unit on your own or without necessary precaution against
injury.
3. Use a hoist if available.

4. Follow the step-by-step instructions in the installation section of this manual.

2.6 Personal Safety

2.6.1 Safety for Persons Wearing Pacemakers

The instrument contains strong magnetic fields, some of which extend beyond the magnet
unit house (see stray field diagram below). These pose no danger to routine users, but are
hazardous to persons with heart pacemakers or other medical implantations.

Danger to life from strong magnetic fields!
Strong magnetic fields may cause serious injuries or death and significant damage to
property.
1. Persons fitted with heart pacemakers must be kept away from the device. The
functionality of the heart pacemaker could be compromised.

2. Persons with metal implants must be kept away from the device. Implants may

heat up or be subject to magnetic attraction.
3

. Ferromagnetic materials, tools, and electromagnets must be kept away from the
magnetic source. Such materials could be subject to magnetic attraction and may
fly around the room, injuring or killing people. Minimum distance 3 meters.

4. Remove magnetic items (jewelry, watches, pens etc.) before carrying out
maintenance work.

5. Keep electronic equipment away from the magnetic source. Such equipment
could be damaged.

6. Keep storage media, credit cards etc. away from the magnetic source. Data could
be erased.

11



Safety

Example of a Stray Field Plot for a Typical 0.47T / 20 MHz Magnet

FRONT VIEW

TOP VIEW

MQ 20MHz LS25

The above figure is an example of a stray filed plot for a typical 0.47T/20 MHz Magnet,
plots for other frequencies are available in the Preinstallation Manual (included on the
minispec software CD).

12



2.6.2

Safety

Safety During Cryogen Refilling

A

2.6.3

Danger of injury due to burns from cold cryogens

Injury from burns may occur when coming in contact with cold cryogens.
1. Avoid tipping over the liquid nitrogen container.
2. Operators should be properly trained on the handling of liquid nitrogen.
3. Warning signs should be in place on liquid nitrogen containers.

Safety When Working with VT Probe Systems

A

2.6.4

Danger of injury due to burns (hot/cold) when working with VT probe
systems

The operator may burn their hands or fingers when touching a very hot or cold
sample, or the top of the VT probe at the gas exit.

1. Wear protective gloves while handling hot or cold samples.
2. Wear protective gloves when working around the VT probe.

3. Only trained personnel should be working with the VT probe system.

Safety When Working with Glassware

A DANGER

Danger of injury from glassware breakage!

Broken glassware may cause minor injuries or material damage, but may also result
in a life threatening situation if hazardous substances are used.

1.If glassware breaks, refer to the corresponding precautions and cleaning/
disinfection instructions.

2. Wear protective equipment.
3. Perform all tasks with the glassware carefully.

4. Before carrying out any maintenance work, remove the samples and use dummy
samples if necessary.

5. Strictly observe the correct sample adjustment, i.e. the maximum sample height.

(2]

.Always transport the glassware with the cover, if applicable. Never turn the
glassware upside down or on it’s side.

. The laboratory supervisor is responsible for:
Establishing and enforcing standard sample handling and cleaning procedures.
Establishing and enforcing the use of protective clothing and equipment.
Training laboratory personnel.

8 4 4 0 ~

Preparing an emergency plan.




Safety
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3 Introduction

The minispec is a benchtop Nuclear Magnetic Resonance (NMR) analyzer for detection of
hydrogen ('H), fluorine ('°F), and other abundant NMR-active nuclei. Its common
application is in polymer, chemical and agrifood industry quality control and quality
assurance (QC/QA), where it is routinely used for fast, reproducible and non-destructive
analysis. The minispec is also used for a diverse range of applications in research and
development (R&D) laboratories in industry, universities, and medical research facilities.

This manual provides instructions on proper installation of the minispec and an introduction
to the use of the minispec hardware and software. Topics covered include:

Installation of hardware (section Installation of the minispec mq-Series [+ 17])

Installation of software for Windows™ XP/7 32-bit/64-bit (section Software Installation [+ 41
1)

Configuration (section Configuration of the Software, the Welcome Box [ 44])
 Proper operation of the system (section General Measurement Handling [ 46])

Once installation and configuration is complete, the user will benefit from the software
introduction to familiarize themselves with the minispec capabilities. For installation
procedures you may also refer to the latest verson of the Pre-Installation manual (booklet).
The software functions (ND/NF systems) are discussed step by step, using pictures to help
familiarise the user with all of the accessible minispec features (sections The minispec
Standard Windows [ 49] and The minispec Menu Functions [ _51]).

Users who wish to program the minispec should refer to the chapter The Experiment Editor
ExpSpel for the mg-Series [ _73]). Finally, for a better understanding of the principles
involved, an introduction to the basics of NMR is provided in section Basic NMR Principles [

Z5].

Figure 3.1: The minispec mq-one Spin Finish Analyser

The minispec.exe software is the standard software running on all mg-Series systems
(ND/NF systems), including the minispec ProFiler, and is described in this manual.

15
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The minispec mg-one analyzers operate with the minispec Plus software, which is
delivered with the system. This is a standalone software package and there are separate
manuals available on the minispec software CD that explain it's operation:

* minispec Plus Administration
* minispec Plus Classic

* minispec Plus Chemometrics
* minispec Plus NoCalibration

* minispec Plus Tempering

The LF-Series systems are also delivered with the minispec Plus software as standard
software. The minispec Plus software is also available for mq-Series systems as an
option.

3.1 Improvements

The minispec mqg-Series is the fifth generation of benchtop pulsed NMR analyzers
produced by BRUKER. Since the first BRUKER minispec series was introduced in the
early 1970’s, there have been many improvements in hardware and software. Highlights of
the new mqg-Series minispec generation include:

- minispec control and user interface software operates under Windows™ XP/7 32-bit/64-
bit.
All “turn-key” applications are included.

» Measurement monitoring is possible via a network-connected PC.
» Spreadsheet/database and statistics functions.
* Main hardware options (not applicable to mg-one analyzers):
— Rapid, easy and tool-free exchange of “intelligent” probes
— Broad-band excitation: 5-65 MHz
— Digital pulse attenuation
— Permanent magnet/probe systems up to 60 MHz ('H)
Note: Some of the features mentioned above may be optional.

The minispec mqg-Series has been designed for easy use with routine QC/QA
measurements and is also suited for complex research work. As part of this design,
BRUKER has developed a user friendly software interface (minispec.exe), which is
configurable and modular in design to allow for all types of applications. The user can
select from a number of user interface layouts (see Changing Analyser Type and
Calibration Permission [+_46]) to suit the applications most commonly used in the
intended work environment.

For features regarding the minispec Plus software, please refer to the corresponding
software manuals available on the CD (see Introduction [ 15]).

16
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3.2 Installation of the minispec mq-Series

In general, the minispec mqg-Series consists of three units:
« Magnet Unit, containing the magnet system and the probe assembly
 Electronic Control Unit with the NMR electronics
« Standard PC user interface for measurement control, data processing, etc.

Figure 3.2: The minispec Magnet Unit (left) and Electronic Control Unit (right).
A number of optional accessories can be added and adapted for use: Gradient Unit (for

pulsed field gradient experiments), electronic balances, auto sampler, temperature control
baths and variable temperature control units, etc.

3.21 Unpacking the System

All manuals and some accessories are packed in the container with the minispec. When
unpacking the instrument ensure that all components listed in the packing list are part of
the delivery.

/\ CAUTION

Danger of property damage due to improper handling.

A The shipping container must remain in an upright position at all times. It has two

compartments separated by a wooden plate: an upper part, which contains the
Electronic Control Unit, and a lower part containing the Magnet Unit. The magnet unit
is secured to the shipping container from below with four bolts.

1. DO NOT tilt the container when removing these bolts.

/\ CAUTION

Accident or material damage hazard from falling or tilting instrument

Instrument may fall down or tilt during installation, retrofitting, dismantling, or while
moving on a cart.

1. Use the carrying handles during lifting.

2. When a table or cart is used, it should meet the requirements in the site planning
guide.

3. The instrument should be secured to the cart or table.

17
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/\ cAUTION
Risk of injury from lifting heavy objects.
A The unit is very heavy and may lead to injury when lifting.
\
/ \\ 1. Do not attempt to lift the unit over the edge of the carton, remove the carton first.

2. Do not attempt to lift the unit on your own or without necessary precaution against
injury.
3. Use a hoist if available.

4. Follow the step-by-step instructions in the installation section of this manual.

To unpack the system:

1. Use a 13 mm wrench to remove the four bolts from the bottom of the container.
2. Remove the shipping straps and open the container.

3. Remove the packing material from around the Electronic Control Unit.

4

Remove the Electronic Control Unit from the container, together with the wooden plate
that it is mounted on (do not tip!). Remove the four mounting bolts from below the plate
using a 13 mm wrench. Once loose, remove the Electronic Control Unit and set it in a safe
location.

5. Remove the packing material from around the Magnet Unit. Removed the retaining screws
or nails from the bottom of the wooden pallet and detach the shipping carton.

6. While keeping it level, carefully lift the Magnet Unit from the pallet using the handles on
either side, and place it on a sturdy cart or benchtop.

When using a hoist, make sure the straps are capable of carrying the magnet’s weight
and are attached in such a way that the magnet cannot fall, slip, topple or turn while being
carried.

7. Once the magnet has been placed the benchtop in it's desired position, the handles can
be retracted. While keeping the handles pressed down, push them below the case (see
figure, arrows 1 and 2).

18
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Figure 3.3: Handles on the Side of the Magnet Unit

8. Remove and retain the clear plastic dust covers from each component of the minispec and
inspect them for damage.

9. If either unit appears to be damaged, contact your BRUKER representative immediately.

3.2.2 Siting Considerations

Place the units on a strong, level, non-magnetic benchtop surface, capable of supporting
their weight (refer to Weights and Dimensions [*_23]). A minimum distance of 10 cm
should be allowed between the back of the Electronic Control Unit and adjacent objects in
order to ensure sufficient air-cooling.

Since objects containing iron can influence the magnetic field inside the Magnet Unit, do
not locate the Magnet Unit within 1 m of large iron objects or within 2 m of moving metallic
objects.

/\ CAUTION

Accident or material damage hazard from falling or tilting instrument

Instrument may fall down or tilt during installation, retrofitting, dismantling, or while

/ moving on a cart.

1. Use the carrying handles during lifting.

2. When a table or cart is used, it should meet the requirements in the site planning
guide.

3. The instrument should be secured to the cart or table.

19
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3.2.3 Electronic Control and the Magnet Unit Connections

The connectors are located on the bottom of the back planes. Connect the two units as
shown in the figures below:

z
b=
=
)
© Magnet Unit
:
w
4321 56
L_220/110 V ac
Ethernet
Figure 3.4: Electronic Control and Magnet Units
1. Main power input.
2. Ethernet connection.
310 5. Connections to the units.

Here is an expanded view of the connections:

Figure 3.5: Back Planes of the Electronic Control Unit (top) and Magnet Unit (bottom)

1. Mains Power Input 4. Interface to Gradient Unit
2. Ethernet (10 Base T) Connection |5. Interface to Electronic Control Unit
3. Interface to Magnet Unit 6. Interface to Gradient Unit

20



3.24

Connections of the Electronic Control, the Magnet and the Gradient Unit

Introduction

The recommended placement of the Gradient Unit in regards to the minispec is with
Gradient Unit between Magnet and Electronic Control Unit. Cable connections have been
constructed with this layout in mind. The sketch and the photo of the back plane of the

Gradient Unit below indicate the cable connections between the units.

-
c
]
=

c

[=}
o
3
w

o  Gradient Unit

o+~
(95}
(8]
-~
[}

Magnet Unit

Etherne‘i
220/110 Vac —

Figure 3.6: Sketch of the Back View of the Connections from the Gradient Unit

3to8and9to 5

Connections to Electronic Control Unit and Magnet Unit.

4t07

Gradient Trigger IN (dotted lines - cable number ‘E 140 1516°).

10to 6

Gradient Pulse OUT (dotted lines - cable number ‘E 140 1515).

Note: The gradient cables ‘E 140 1515 and ‘E 140 1516‘ must not be mixed up. Damage

to the minispec units may occur!

S
-
s
=5
;5

2

>
-
=
I
é/

naas

N
Sz
35
<f
<3

Figure 3.7: Back View of the Gradient Unit

1. Gradient Trigger IN 4. Power ON/OFF

2. Magnet Unit IN

5. Magnet Unit OFF

3. Mains Power IN

6. Gradient Pulse OUT
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3.25 Non mqg-Series Standard Systems

Installation of mg-one systems differ in that there is no separate electronics unit, all the
electronics required have been installed in the magnet unit. In addition, a pulsed gradient
unit is not available for mg-one analyzers.

LF50H/LF90/LF110 systems come with a different magnet unit, one which is typically more
heavy as outlined above.

Figure 3.8: The minispec LF90 and LF110

In contrast to LF-Series systems, the minispec ProFiler has a hand-held magnet/probe
unit, which is delivered in a small case.

Figure 3.9: The minispec ProFiler

For more details refer to the Pre-Installation manual (included on the minispec software
CD).

22
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3.3 Specifications mq-Series

3.3.1 Weights and Dimensions

Electronic Control | Magnet Unit Gradient Unit
Unit
Dimensions (W x H x| 23 x 31 x 60 47 x 31 x 60 23 x31x60
D)incm
Weight (kg) 20 depends on magnet |25

3.3.2 Electrical Specifications

minispec mq-Series systems (non-wideline / see corresponding label on back of the unit)

The voltage of the power supply has been set by BRUKER before deliver of the
instrument. Depending on the country of use, BRUKER has set the minispec to 110V or
230V. The voltage of the power supply must not be changed by the user.

Input: 110 V: 90 — 132 VV AC / 50-60 Hz / 2.5 AT (2 pieces)
Input: 230 V: 220 — 250 V AC / 50-60 Hz / 2.5 AT (2 pieces)

minispec mq-Series systems (wideline versions / see corresponding label on back of the unit) and
all other minispec analyzers:

The instruments (wideline) are specified for the following mains voltages:
Input Voltage Range: 100 — 240 V AC 50/60 Hz

Fuse rating mg-Series ND and mg-one: 2 x 2.5 AT

Fuse rating mg-Series NF: 2 x 3.15 AT

Note: mqg-Series instruments were originally delivered with non-wideline power supplies,
but this has been changed to a wideline version.

All Systems

Grounding is vital for the safe operation of the instrument. Never operate with the
grounding conductor disconnected. If the local wiring does not provide a ground, an earth-
to-chassis connection must be added at the user’s location.

recommended to connect the minispec to a separate circuit that is not used by any other
equipment. Furthermore, a voltage stabilizer or UPS may be required to avoid instrument
instabilities or other unexpected system behavior caused by a fluctuating input voltage.

n Note: Since the input voltage may be unstable in a laboratory environment, it is
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3.3.3 Environmental Considerations

The minispec should be used in areas free from direct sunlight, heat sources and power
cables.

A constant temperature is important for field stability and accurate reproduction of
measurement results. The magnet temperature can be factory-adjusted between 35-45°C
(up to 50 degrees is possible, but this may require special adjustment of the probe — refer
to the section on Settings). This temperature range has been selected because it is well
above expected ambient (laboratory) temperatures.

The usual magnet temperature (if not indicated different) is 40°C for all instruments.
Exceptions are:

* mg-one Polymer Analyzer: 50°C
 the minispec LF-Series: 37°C

Cooling of the console electronics is accomplished with a closed cycle zero maintenance
air-cooling system, so that no external air is ventilated through the console or the Magnet
Unit. In some factory environments where dust may be a problem, it may be desirable to
house the minispec computer in a clean room or ventilated housing, which is protected
from dust. The console and Magnet Unit can be placed nearby at a location more
convenient for process personnel.

The instrument contains strong magnetic fields, some of which extend beyond the magnet
unit housing (see stray field diagram below). These pose no danger to routine users, but
are hazardous to persons with heart pacemakers or other medical implantations.

Danger to life from strong magnetic fields!

Strong magnetic fields may cause serious injuries or death and significant damage to
property.

1. Persons fitted with heart pacemakers must be kept away from the device. The
functionality of the heart pacemaker could be compromised.

2. Persons with metal implants must be kept away from the device. Implants may
i E heat up or be subject to magnetic attraction.
3. Ferromagnetic materials, tools, and electromagnets must be kept away from the

magnetic source. Such materials could be subject to magnetic attraction and may
fly around the room, injuring or killing people. Minimum distance 3 meters.

4. Remove magnetic items (jewelry, watches, pens etc.) before carrying out
maintenance work.

5. Keep electronic equipment away from the magnetic source. Such equipment
could be damaged.

6. Keep storage media, credit cards etc. away from the magnetic source. Data could
be erased.
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Danger of injury or material damage due to strong magnetic fields!

Injury or material damage may result due to the strong magnetic fileds that can draw
metallic objects towards the magnet.

1.DO NOT locate the instrument next to large iron-containing objects or near
moving metallic objects.

2. DO NOT place any iron-containing object on the minispec magnet unit. Be aware
that the magnetic field can erase magnetic recording media such as computer
diskettes or credit cards.

3. DO NOT place these items or clothing containing these items on the magnet unit.

4. Leave the dust cover on the probe canal when the instrument is not in use.

With minispec ProFiler systems check the corresponding instructions for this device — this
system has a strong magnetic stray field, safety instructions must be followed!

3.4 Interpretation of the LEDs

Users receive continuous indication of the status of the different units in the form of light
emitting diodes (LEDs), which are built into the front panel of the units.

3.41 mgq-Series /| LF-Series / ProFilter (Electronic Control Unit Only) Systems

Electronic Control Unit (not applicable to mqg-one systems)
Right LED, Connection status indicator:
* ON (green): PC communication to the Electronic Control Unit is OK.
* OFF: No communication between the Electronic Control Unit and the PC.

Left LED, Status indicator:
* ON (green): The Electronic Control Unit is working.
* OFF: The Electronic Control Unit is not working.

Magnet Unit

Right LED, indicates the magnet temperature status:
* RED: Pre-heating.
* YELLOW: Transition to normal heating.
* GREEN: Temperature is OK.

Left LED, Connection status indicator:

* ON (green): Communication between the Electronic Control Unit and Magnet Unit is OK
(mg-Series / LF-Series).

* OFF: No communication between the Electronic Unit and Magnet Unit (mg-Series / LF-
Series).

* ON (blue)/OFF: Power on / off (mg-one analyzers only).
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3.4.2

Gradient Unit (not applicable to LF-Series systems)
Right LED:

* ON (green): Gradient Unit is on standby.

» OFF: Gradient pulse execution.

Left LED, connection status indicator:
* ON (green): Communication between the Electronic Control Unit and Gradient Unit is OK.
¢ OFF: No communication between Electronic Control Unit and the Gradient Unit.

mgq-one Systems

3.5

System / Magnet and Electronic Unit

Right LED, indicates the magnet temperature status:
* RED: Pre-heating.
» Purple: Transition to normal heating.
* GREEN: Temperature is OK.

Left LED, power indication.

Calibration Samples and Probe Exchange

A

The Magnet Unit cover has two outer hatches or doors.

» The first one is on the front panel of the unit and can be used to contain the calibration
samples. Pressing on the upper part of the hatch will unlock and open it.

* The second is the top hatch, which allows access into the minispec magnet compartment
and permits quick and tool-free exchange of probes.

To replace a probe you must open the hatch at the top of the Magnet Unit.

1. This is done by first releasing the front hatch to expose a red button in the front of the
unit.

2. Press the red button to release the top latch and open the hatch as far as it will go.

3. A second hinged lid, blue in color, will be visible. Lift it up and lean it against the outer
hatch.

Danger of injury due to falling lid

The hinged lids may close unexpectedly during probe exchange causing injury to
hands or fingers.

1. Ensure that the gas spring on the outer lid is operating correctly.

2. The blue inner hinged lid does not have a gas spring, use extreme care when
exchanging the probe assembly.
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4. The probe assembly is fixed with two quick-release fasteners. To release the fasteners,
lift up the D-rings until they snap into a vertical position, then use them to rotate the
fastener posts until released (refer to the figure below).

5. While grasping the D-rings, carefully tug upward to loosen the preamplifier connection
under the mounting plate, then raise the assembly (mounting bar with probe and
preamplifier attached) out of the magnet gap.

'

Figure 3.10: Ring of the Quick-Release Fastener (left) and the Raising of the Probe Assembly (right)

1. Rings

2. Rotating the rings.

To open the fasteners, turn the rings (1) upward and rotate them (2)

Replace the assembly by following the instructions in reversed order.

“Intelligent” probes were developed for the minispec mqg-Series. If you exchange a probe
the software will read the most important parameters (pulse length, resonance frequency)
from the probe itself. The software will prompt the user to confirm the settings. For fine-

tuning, it is recommended running the Update Settings procedure afterwards (see The

minispec Menu [ 56]).

Probe exchange for mqg-one analyzers is out of the range of intended use for this product.
For this analyer only trained Bruker service personnel are allowed to exchange probes
during service.

27



Introduction

28



Technical Data

4 Technical Data

4.1 General Information
No. Series Type Weight | Length | Width Heigth
(kg) (cm) (cm) (cm)

1 mqg-one SFC 95 65 50 33
2 mg-one Polymer 130 65 50 33
3 mqg-one Fat 130 65 50 33
4 mqg-one Spin Finish 130 65 50 33
5 mqg-one Hydrogen 130 65 50 33
6 mqg-one Seed 130 65 50 33
7 mqg-one Seed XL 150 65 50 33
8 mqg-Series mq60 145 65 75 33
9 mqg-Series mq40 145 65 75 33
10 |mqg-Series mq20 Airgap 33 mm* 145 65 75 33
11 mqg-Series mq20 Airgap 25 mm* 135 65 75 33
12 |mqg-Series mq10 135 65 75 33
13 |mqg-Series mq7.5 155 65 75 33
14 | mqg-Series mq20 Airgap 33 mm with PGU* 170 65 100 33
15 | mqg-Series mq20 Airgap 25 mm with PGU* 160 65 100 33
16 | mg-Series mq10 with PGU 160 65 100 33
17 | mg-Series mq7.5 with PGU 180 65 100 33
18 |mqg-Series mgq-ProFiler 25 65** 25** 33**
19 | mg-Series PGU only 25 65 25 33
20 |LF Series LF50 155 65 75 33
21 | LF Series LF50H**** 210 100 65 125
22 |LF Series LFQQ***** 350 105 70 150
23 |LF Series LF110**** 420 105 70 150

Table 4.1: Technical Data: General Information

All specifications above are without the PC. Weights and dmensions apply to the
instruments, not to the packaged systems.

* For configurations with a high temperature probe, an additional table is used. However,
this table is not considered in the specifications provided.

** Control unit only
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*** PGU excluded

**** Magnet is integrated in a turnable and moveable frame with a plate in the bottom,
which can be used to position the control unit. The frame is included in the specifications.

**** The system comes on a cart and is included in the specifications.

30



Technical Data

4.2 Connection Values
Electrical
No. | Series Type ND/NE/ | Voltage/ Apparent Circuit Frequency
NF VAC Power Protection | /Hz
Consumptio | (Two
n, Maximum/ | indication
VA s: NF/ND
Series)
1 |mg-one |SFC NE 100-240 180 25AT 50-60
(2 pieces)
2 |mg-one |Polymer NE 100-240 180 25AT 50-60
(2 pieces)
3 |mg-one |Fat NE 100-240 180 25AT 50-60
(2 pieces)
4 |mg-one |Spin Finish NE 100-240 180 25 AT 50-60
(2 pieces)
5 |mg-one |Hydrogen NE 100-240 180 25AT 50-60
(2 pieces)
6 |mg-one |Seed NE 100-240 180 25AT 50-60
(2 pieces)
7 |mg-one |Seed XL NE 100-240 180 25AT 50-60
(2 pieces)
8 |mg- mqg60 NF/ND 100-240 300/250 3.15/2.5 AT 50-60
Series (2 pieces)
9 |[mg- mqg40 NF/ND 100-240 300/250 3.15/2.5 AT 50-60
Series (2 pieces)
10 |mg- mqg20 Airgap 33| NF/ND 100-240 300/250 3.15/2.5 AT 50-60
Series mm* (2 pieces)
11 |mg- mqg20 Airgap 25| NF/ND 100-240 300/250 3.15/2.5 AT 50-60
Series mm* (2 pieces)
12 |mg- mqg10 NF/ND 100-240 300/250 3.15/2.5 AT 50-60
Series (2 pieces)
13 |mg- mq7.5 NF/ND 100-240 300/250 3.15/2.5 AT 50-60
Series (2 pieces)
14 |mg- mqg20 Airgap 33| NF/ND 100-240*** 300/250 3.15/2.5 AT 50-60
Series mm with PGU* (2 pieces)
15 |mg- mqg20 Airgap 25| NF/ND 100-240*** 300/250 3.15/2.5 AT 50-60
Series mm with PGU* (2 pieces)
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No. | Series Type ND/NE/ Voltage/ Apparent Circuit Frequency
NF VAC Power Protection | /Hz
Consumptio | (Two
n, Maximum/ | indication
VA s: NF/ND
Series)
16 |mg- mq10 with PGU | NF/ND 100-240*** 300/250 3.15/2.5 AT 50-60
Series (2 pieces)
17 |mg- mq7.5 with PGU | NF/ND 100-240*** 300/250 3.15/2.5 AT 50-60
Series (2 pieces)
18 |mg- mgq-ProFiler NF/ND 100-240 300/250 3.15/2.5 AT 50-60
Series (2 pieces)
19 |mg- PGU only NF/ND 110/230 300 25A 50-60
Series factory set (2 pieces)
20 |LF Series |LF50 NF/ND 100-240 300/250 3.15/2.5 AT 50-60
(2 pieces)
21 |LF Series | LF50H**** NF/ND 100-240 300/250 3.15/2.5 AT 50-60
(2 pieces)
22 |LF Series | LFOO***** NF/ND 100-240 300/250 3.15/2.5 AT 50-60
(2 pieces)
23 |LF Series |LF110***** NF/ND 100-240 300/250 3.15/2.5 AT 50-60
(2 pieces)

Table 4.1: Electrical Connection Values
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4.3

Operating Conditions

Environment

No. | Series Type Temperature | Temper | Relative Decreasing IP
Range, ature Humidity at Linear Till Safety
Maximum/°C | Range, |31 °C, Relative Class
Ideal/°’C | Maximum/% | Humidity <
50% at 40°C,
maximum/%

1 |mg-one SFC 18-28 22-25 80 (non- <50% IP20
condensing)

2 |mg-one Polymer 18-28 22-25 80 (non- < 50% IP20
condensing)

3 |mg-one Fat 18-28 22-25 80 (non- <50% P20
condensing)

4 |mg-one Spin Finish 18-28 22-25 80 (non- < 50% IP20
condensing)

5 |mg-one Hydrogen 18-28 22-25 80 (non- < 50% IP20
condensing)

6 |mqg-one Seed 18-28 22-25 80 (non- <50% P20
condensing)

7 |mg-one Seed XL 18-28 22-25 80 (non- < 50% IP20
condensing)

8 |mqg-Series |mq60 18-28 22-25 80 (non- < 50% P20
condensing)

9 |mqg-Series |mqg40 18-28 22-25 80 (non- <50% P20
condensing)

10 |mg-Series |mqg20 Airgap 18-28 22-25 80 (non- <50% P20
33 mm* condensing)

11 |mg-Series |mqg20 Airgap 18-28 22-25 80 (non- < 50% IP20
25 mm* condensing)

12 |mqg-Series |mq10 18-28 22-25 80 (non- <50% P20
condensing)

13 |mg-Series |mq7.5 18-28 22-25 80 (non- <50% P20
condensing)

14 |mg-Series |mqg20 Airgap 18-28 22-25 80 (non- < 50% IP20
33 mm with condensing)

PGU*

15 |mg-Series |mqg20 Airgap 18-28 22-25 80 (non- <50% P20

25 mm with condensing)
PGU*

16 |mg-Series |mq10  with 18-28 22-25 80 (non- < 50% P20
PGU condensing)

17 |mg-Series |mq7.5 with 18-28 22-25 80 (non- <50% P20
PGU condensing)
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No. | Series Type Temperature | Temper | Relative Decreasing IP
Range, ature Humidity at Linear Till Safety
Maximum/°C | Range, | 31 °C, Relative Class
Ideal/°’C | Maximum/% | Humidity <
50% at 40°C,
maximum/%
18 |mqg-Series | mq-ProFiler 18-28 22-25 80 (non- < 50% IP20
condensing)
19 |mg-Series |PGU only 18-28 22-25 80 (non- <50% IP20
condensing)
20 |LF Series |LF50 18-28 22-25 80 (non- < 50% IP20
condensing)
21 |LF Series |LF50H**** 18-28 22-25 80 (non- < 50% IP20
condensing)
22 |LF Series |LF9Q***** 18-28 22-25 80 (non- < 50% IP20
condensing)
23 |LF Series |LF110***** 18-28 22-25 80 (non- < 50% IP20
condensing)
Table 4.1: Operating Environment
Description Manual Bruker Part
Number
minispec  Software CD-ROM|The minispec Pre-Installation manual is E1405284
(Windows 7/Office 2010) available as a PDF document on this CD-
ROM.

Table 4.2: Bruker Site Planning Guides

Normal environmental conditions (CAN/CSA 61010-1-12; IEC 61010-1: 2010; ANSI/UL 61010-1)
* Indoor use only.
» Maximum operation altitude: 2000 m.

 ldeal operating temperature: 22-25 °C. Minimum operating temperature: 18°C Maximum
operating temperature: 28°C Humidity (non-condensing): 20-80%

* Maximum relative humidity 80% for temperatures up to 31 or decreasing linearly to 50%
relative humidity at 40 °C.

* MAINS supply voltage fluctuations up to £10% of the nominal voltage.

* TRANSIENT OVERVOLTAGES up to the levels of OVERVOLTAGE CATEGORY II.
* Pollution degree 2.

* Protection class IP20.
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4.4 Rating Plate

The rating plate is located at the power input and includes the following information:

Bruker Biospin GmbH Bruker Biospin GmbH
an Silberstreifen_ B Iél! Silberstreifen
V) D-76287 Rheinstetten o D-76287 Rheinstetten
WEEE DE84716930 WEEE DEB84716930
Minispec Minispec
MQ Series NF3730 c € MQone Series NE3726 c €
100-240V ~ 50/60HZ 300W 100-240V~ 50/60HZ 180W

Figure 4.1: The minispec MQ and MQone Series Rating Plates
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5 Transport, Packaging and
Storage

device must only be carried out by Bruker Service or personnel authorized by Bruker.

n Installation, initial commissioning, retrofitting, repairs, adjustments or dismantling of the
Damage due to servicing that is not authorized by Bruker is not covered by your warranty.

5.1 Symbols on the Packaging

The following symbols are affixed to the packaging material. Always observe the symbols
during transport and handling.

Top The arrow tips on the sign mark the top of the
package. They must always point upwards;

otherwise the content may be damaged.

Fragile Marks packages with fragile or sensitive
contents.

Handle the package with care; do not allow the
package to fall and do not allow it to be
impacted.

Protect Against Moisture , « * |Protect packages against moisture and keep
dry.

Attach Here Lifting gear (lifting chain, lifting strap) must

only be attached to points bearing this symbol.

Note the location of the center of gravity when
lifting and transporting.

Weight, Attached Load Indicates the weight of packages.

Handle the marked package in accordance
with its weight.

Center of Gravity ‘ Marks the center of gravity of packages.
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5.2

Permitted Stacking Load

Indicates which are

stackable.

packages partially

Do not exceed the maximum load-bearing
capacity specified on the symbol in order to
avoid damaging or destroying the content.

Do not Damage Air-tight
Packaging

The packaging is air-tight. Damage to the
barrier layer may render the contents
unusable.

Do not pierce.

Do not use sharp objects to open.

Component Sensitive to
Electrostatic Charge

The packaging contains components which
are sensitive to an electrostatic charge.

Only allow packaging to be opened by trained
personnel.

Establish  potential  equalisation  before
opening.
Protect from Heat \\l// Protect packages against heat and direct
//l " | sunlight.
”~N
|
Protect from Heat and :Sl/, Protect packages against heat, direct sunlight
Radioactive Sources A4 ’/l\\ and radioactive sources.
|

Table 5.1: Symbols on the Packaging

Inspection at Delivery

Upon receipt, immediately inspect the delivery for completeness and transport damage.

Proceed as follows in the event of externally apparent transport damage:

* Do not accept the delivery, or only accept it subject to reservation.

* Note the extent of the damage on the transport documentation or the shipper's delivery

note.

« Initiate complaint procedures.

Note: Issue a complaint in respect to each defect immediately following detection.
Damage compensation claims can only be asserted within the applicable complaint

deadlines.
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5.3 Packaging

About Packaging

The individual packages are packaged in accordance with anticipated transport conditions.
Only environmentally friendly materials have been used in the packaging.

The packaging is intended to protect the individual components from transport damage,
corrosion and other damage prior to assembly. Therefore do not destroy the packaging
and only remove it shortly before assembly.

It is recommended to store the packaging for later use in the event that you need to return
the unit to Bruker.

Handling Packaging Materials
Dispose of packaging material in accordance with the relevant applicable legal

requirements and local regulations (see Dismantling and Disposal [ 79]).

54 Storage

Storage of the Packages
Store the packages under the following conditions:
* Do not store outdoors.
» Store in dry and dust-free conditions.
» Do not expose to aggressive media.
* Protect against direct sunlight.
» Avoid mechanical shocks.
» Storage temperature: 15 to 35 °C.
* Relative humidity: max. 60%.

« If stored for longer than 3 months, regularly check the general condition of all parts and
the packaging. If necessary, top-up or replace preservatives.

Note: Under certain circumstances, storage instructions may be affixed to packages
which expand the requirements specified here. Comply with these accordingly.

39



Transport, Packaging and Storage

40



6 Getting Started

In general, minispec systems which are delivered with a personal computer already have
the minispec software installed. In this case, the user can skip the software installation

instructions (see Software Installation [ _41]) and proceed to the instructions on
initialization of the PC-to-minispec connection (see Connecting the PC to the minispec for
the First Time [» 42]).

When a user provides their own personal computer, or if software needs to be reinstalled
for use with the minispec, refer to the installation instructions below.

The middle sections of this chapter describe how the user can configure the software
(minispec.exe) by selecting the analyser type from among the list of pre-set types (see

Wake-up State of the minispec.exe Software [ 44]) and by setting the user level e.g. allow

calibrations or only measurements (section Configuration of the Software, the Welcome Box
[ 44]).

Later, a short introduction provides general instructions on how to run measurements
(section General Measurement Handling [ 46]).

A list of all standard applications is added at the end of the chapter (section List of Standard
Applications [ 47]).

6.1 Software Installation

Execute the following steps only if the PC has not been pre-configured for the
minispec.

1. Insert the installation CD in your drive.

2. Open the Windows EXPLORER and check the CD for a ReadMe.txt file. If a ReadMe.txt
file is available, follow the instructions provided in this file.

3. If not, execute the Setup file with a double click or select the setup entry with the right
mouse button and select Open in the displayed menu.

4. Follow the instructions in the Setup program.

» The Sefup program copies the files into the folder you specify during the setup
procedure.

5. To start the minispec software, double click on the minispec.exe file in the main folder.
Alternatively, you can create a shortcut on the Windows desktop to the file minispec.exe.

With the first start up, the configuration of the minispec software (minispec.exe) is set to
the SFC-Analyzer. To change the settings refer to the section Wake-up State of the

minispec.exe Software [ 44].

The mg-one instruments and LF-Series systems operate with the minispec Plus software,
with the above described minispec.exe software running in the background as an
acquisition server. Systems that are equipped with minispec Plus software will install this
additional program automatically. The manual “minispec Plus Administration”, together with
the other minispec Plus manuals, provide further details. These can be found on the
minispec software CD in the folder ,Documentation’.
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Systems equipped with minispec Plus software do not necessarily need to start the
minispec.exe software before using minispec Plus. If the system is properly installed (refer
to the corresponding minispec Plus manual), then minispec Plus can be opened without
first opening the minispec.exe software. However in some cases it might be useful to first
run the minispec.exe software to make sure there is a proper network connection from PC
to the minispec, then afterwards switch to minispec Plus program.

Please note that for proper installation of minispec Plus software further software
requirements may apply, refer to the corresponding minispec Plus manual for details.

6.2 Connecting the PC to the minispec for the First Time

6.2.1 Direct Cable Connection

1. If the software is running (e.g. after installation), then exit the minispec software.

2. Connect the PC to the minispec using the blue crossed-wire UTP-cable, which is
delivered with the minispec (10-Base-T with RJ45 connectors, see the figures in the

section Installation of the minispec mq-Series [» _17]).

3. Power ON the instrument and computer.

4. If not already installed, use the Network entry in the Windows™Control Panel to install a
TCP/IP protocol on your PC. The exact procedure for adding the TCP/IP protocol
depends on the Windows™ version that is used, refer to the Windows™ software
documentation for a detailed description.

5. Select TCP/IP ‘Properties’. Confirm or enter the following entries: IP-address:
192.168.1.2 Subnet-mask: 255.255.255.0

» [f other values are defined, alter them accordingly. Re-boot your computer.
6. Start the minispec software on the PC.

= Some program information will be displayed for a short time, after which a Welcome
Box will be displayed. Entries in the select boxes indicate how the PC will attempt to
connect to the minispec console and what applications will be loaded.

7. Connect to the minispec electronic unit (mg-Series) using the indicated default serial
number ‘ND0O0OOQ’/ ‘NFO000’ by clicking ‘OK’ in the displayed Welcome Box.

= Communication is attempted from the PC software over the TCP/IP to the CPU/
Ethernet controller in the console at the default IP address 192.168.1.1. Connection is
indicated at the top status line with the message, for example, Connected to ND1428.
The IP address of the console will be displayed in a small box on the bottom edge of
the program window.

» [f the connection with the default serial number NDOOOO/NFO000 cannot be
established, re-try using the IP address ‘192.168.1.1° instead of the default ‘ND0O00O’
from the Welcome box settings.

®» For mqg-one analyzers the default serial number is ‘NEOOOO’ and the default IP
address is 192.168.1.200.

8. If the connection still fails, make sure the cable is a crossed-wire twisted pair cable and
that it is connected properly.

» [f connection still does not succeed, then the problem may be due to incorrect IP
addresses or Subnet mask for the PC or the minispec. Normally the minispec console
is shipped with the default IP address set to 192.168.1.1 (mg-one 192.168.1.200) and
a subnet mask of 255.255.255.0. However, in some circumstances the minispec

42



Getting Started

console may be set to other values (e.g. if a minispec has already been installed on a
network, whereas another IP address will be needed, or a PC is being exchanged, or
the software had to be reloaded on a fresh hard disk).

9. If a connection cannot be established and the setting of the console IP address is
suspect, it may be necessary to open the console (mg-Series instruments / LF-Series)
and set dip switch # 1 of the CPU/Ethernet board to the ON position. This automatically
forces the console IP address to use 192.168.1.1, whereas the connection should work
after following steps 4, 5 and 6.

For mg-one analyzers an IP address reset is also possible. The Internet web browser
page contains information (see Help menu) on how to do this, however please check with
your local Bruker support for more details, if necessary.

6.2.2 Connection of PC and minispec via a Network

» Ask the network administrator to assign unique and valid IP addresses for the PC and the
minispec console.

P Establish a direct connection as described in the section Direct Cable Connection [ _42]
and exit the minispec software after the connection procedure has been completed
successfully.

» To set the minispec console IP address from the PC software, proceed as follows (not for
mg-one analyzers / mg-Series NF systems):

1. Start the minispec program.

2. Select Setup from the Welcome Box and ignore the password input by typing <Enter>
twice (only possible if no password has been previously defined).

3. Select Customize, then Connection in the dialog box.

4. In the Connection dialog box select the IP-Address and connect with the serial number
NDxxxx/NFxxxx as prompted by the program or use ‘“192.168.1.1° as serial number
instead.

» A configure box will be displayed.

5. Input the new minispec console IP address and any other necessary entries (e.g. subnet
mask) based on the network administrator’s instructions. Normally one can use the
default entries. Follow the software instructions and switch off the minispec accordingly at
the end of this procedure.

= Make sure the dip switch #1 of the CPU Ethernet board of the minispec electronics
unit is now set to ‘OFF’ (see also section Direct Cable Connection [»_42] #9 and the
‘Notes’ below).

6. On the PC, use the Network entry in the Windows ‘Control Panel' (press the ‘Start’
button and select ‘Settings’ to get the Control Panel), to modify the TCP/IP properties.
Enter the new IP address for the PC and the other network specific entries according to
the network administrator’s instructions, than turn off the PC.

® Both units — minispec and PC — are now updated with the new IP addresses.

7. Remove the direct connection between the PC and the minispec, then connect them to
the network. Attention: Do not use the blue direct connection cable delivered with the
minispec.

8. Switch ON the minispec console and the PC.
9. Run the minispec software for Windows by confirming the Welcome Box entries.

» The connection is indicated on the top status line with the message, e.g. “Connected
to ND1428” and the IP address of the console will be displayed in a small box on the
bottom edge of the program window.
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= \When following this procedure, one must not edit the Windows ‘hosts’ file on the PC.
Entries in this file are maintained automatically by the minispec software.

Notes:
In case of connection problems:
1. Double check the PC IP address and other network related entries.

2. Recheck if straight-through twisted pair cables are used, in this case they should not be
used. It may be necessary to open the console and set dip switch #1 of the CPU/Ethernet
board to the OFF position (after step 3). This allows the console IP address to be set to
something other than 192.168.1.1.

= Now, whenever you start the minispec software, contact to the minispec will be
established automatically.

mgq-one Analyzers /| mg-Series NF Systems

For mg-one systems and mq-Series NF systems the IP address is set via the Internet Web
browser:

1. Open the Internet Explorer of your Windows OS on your PC.

2. Type the default address 192.168.1.200 in your browser to connect to the mg-one system
or the NF-Series system.

3. Windows security will prompt for a User Name and a Password. Use “root” as a User
Name and “BRUKER” as your Password.

® You should now have access to the main menu.
4. Select “Support” and afterwards “Network parameters”.
5. Set the new IP address and type on “Apply Changes”.
6. Re-boot the analyser to activate the new address.

6.3 Wake-up State of the minispec.exe Software

When the software starts, a general dialog is displayed concerning the software version
and the copyright. Then a Welcome Box opens and displays information about the
configuration of the system. The wake-up configuration is the configuration used with
your last minispec session. To continue with the same settings and start the minispec

software click OK. If you want to change the settings refer to the next section,
Configuration of the Software, the Welcome Box [ 44].

As already mentioned the standard software of mg-one analyzers and the LF-Series is the
minispec Plus software. Corresponding manuals for this software are available on the

minispec CD (for a list see Introduction [ _15]).

6.4 Configuration of the Software, the Welcome Box

The configuration of the system (i.e. the connected minispec, the selected applications, the
analyzer type, and the calibration permission) can be inspected and edited via the
Welcome Box. The Welcome Box can also be user configured. Users can control whether
or not this box will be opened on program start. This is done by selecting or deselecting the
entry Welcome Box in the pull-down menu View (see also The View Menu [ _65]).
Deselecting the item Display this Window on Startup will also turn off the Welcome Box
when the box appears on program start.
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Figure 6.1: The Welcome Box
Several symbols, entries and buttons are displayed in the Welcome Box:
» Applications to be loaded (path and file name in the white field).
» Serial number of the minispec to be connected to (here: ND1428).
» Type of analyzer (here: NMR Analyser).
» The calibration permission is symbolized using a flag.

The ‘wake-up’ application can also be selected for future program start-up. When the user
has finished with the selections, the ‘OK’ button is used to start the software.

To change the configuration, press the Setup button. The configuration is protected by a
simple log-in mechanism.

» First log-in: Press the Setup button. Enter and confirm a password. The password will be
saved automatically and you will need it for every subsequent log-in. Handle the
password carefully! Only users who have permission to make changes to calibrations
and software configurations should have knowledge of the password. If password
protection is not desired, simply click OK or <Enter> without entering a password when
the password entry box appears and confirm this in the following box.

» Later log-in: Press the ‘Setup’ button and enter the password or click twice on OK if
password protection is not used.

6.4.1 Selecting Applications and Connections

If you click Setup in the Welcome Box you will open the configuration level of the welcome
dialogue. This password procedure is described in the section above. Up to 20 applications
can be selected simultaneously for every analyzer type (except for the SFC-Analyzer
where only one application is allowed) to be loaded at the startup. To add applications to
the list use Browse... to access a file selector box or use Delete to remove applications
from the list.

To choose another minispec, use the ‘Select’ button in the ‘Select minispec to connect to’
field.
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6.4.2 Changing Analyser Type and Calibration Permission

Use the Customize button in the configuration level (see Selecting Applications and
Connections ['_45]) to open a dialog box. In this window the analyzer type and the
calibration permission can be selected by checking the corresponding select box with a
mouse click. Two options, RELAXATION TIME and the NMR analyzer, require a license
number to operate. The number will be requested while connecting to the minispec (after
you click the OK button in the Welcome Box) when one of these options is selected. If
ordered with the system, this license number is issued on the first page of this booklet,
labeled as the ExpSpel license number.

6.5 General Measurement Handling

The most important commands that are used to control measurements are: the Run
command to start a measurement and the Stop command to interrupt a measurement in
progress. Measurements can be started through a number of commands and by activating
a number of software icons or features. For example, the general Run command can be
started through the RUN button from the top icon bar or bottom button panel, from the pull-
down menu minispec, or by simply pressing <Enter>. If the user has been given
permission to perform sample calibrations, then the Calibrate command is available. Other
forms of measurement are available for convenience, including a repetitive run command
and a command to detect the raw NMR signal.

The following sequence of actions is generally followed in preparation for measurements:
1. Turn on your minispec and your PC (if they were turned off).

» \Wait until the console CPU/Ethernet process boots, as indicated by the lighting of the
left (green) LEDs located on the front edge of the magnet and console.

2. Connect the PC to the minispec you want to use and configure the software, e.g. choose
applications or an analyzer type.

» \Wait until the right LED on the magnet unit is green. This can take up to 3 hours to
ensure optimum temperature stability. If the system was turned off for several days, or
it was moved to another place, insert the calibration sample with 0% solid content and
run the Update Settings routine.

» |f you want to perform SFC (Solid Fat Content) determinations and the Analyzer type
is not set to SFC-Analyzer, then make sure the option ‘SFC’ is checked in the
Instrument Settings submenu of the pull-down menu the minispec before you start
the Update Settings.

3. Depending on the application you use (see your application description), start your
measurement or calibration with the Run or Calibrate command.

The software includes full automatic tuning routines to adjust the measurement settings,
for example pulse length, receiver gain, and magnetic field. You can tune these settings
periodically to ensure the instrument validity over time.

The Daily Check command should be executed once a day to check the most important
instrument settings and hardware functionality.

Every 24 hours, a yellow field on the right of the display will automatically indicate the need
for another Daily Check. Running the Daily Check periodically ensures conformance to
Good Laboratory Practice (GLP).
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6.6 minispec mqg-one Systems and LF Analyzers

As indicated before, the mg-one and LF-Series systems are intended to be operated using
Bruker’s minispec Plus software GUI. The Update Settings, Daily Check, Calibration
and Measurement procedures are also included in both the minispec.exe and minispec
Plus software, but when minispec Plus software is available it is recommended to operate
those systems using this software.

Because all the applications and calibrations are prepared for the user using the minispec
Plus software, the application pool for minispec.exe, known from the mqg-Series systems,
will not be installed on mg-one / LF-Series systems. It is also not possible to copy mg-
Series applications to mg-one systems, as the pulse sequence programming differs slightly
for both systems. Therefore, all instructions in the following sections are mainly of use for
mq-Series users, including the mg-ProFiler systems. For instructions on minispec Plus
software, please refer to the corresponding manuals. For

minispec Plus users, the minispec.exe will only be used in a few exceptional cases,
including:

» to check the connection between PC and minispec system in some cases
* to run “Update Settings” / “Daily Check” via the minispec.exe software
« for diagnostic purposes.

Service technicians may use the minispec.exe software on mg-one and LF-Series systems
more frequently.

6.7 List of Standard Applications

With the mg-Series minispec, nearly all standard applications are executable without any
license number. The most common applications are listed below:

« Solid Fat Content Determination in Fat Compositions using Solid Fat Content (Ratio)
Calibration Standards with ISO Certificates.

* Oil / Fat & Moisture in
— Chocolate
— Cocoa Powder
— Milk Powder
* Oil & Moisture in
— Seeds
— Nuts
— Olives
» Droplet Size Analysis in Emulsions (protected)
» Xylene soluble Content in Polypropylene
» Additive Determinations in Polymers
» Polybutadiene / Polystyrene Content in SBR
» Density in Polyethylene
 Crystallinity Determinations in Polymers
» Spin-Finish Determinations (OPU and WPU) on Textile Fibers
» Total Hydrogen Content Determinations in hydrocarbons like
— Jet fuel
— Other Distillates
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* Oil Content Determinations in Wax / Paraffin
* Oil Content Determination in
— Sulfur
— Other Chemical Powders
* Relaxation Time Analysis on Contrast Agents / Liquids
* Moisture Content Analysis on Powders and Tablets
» Contactless Weighting of Powders and Tablets
* Fluorine Content in Toothpaste
» Solid Fat Content (Ratio) Calibration Standards with ISO Certificates

The minispec software for mqg-Series systems comprises various minispec Application
Pools (like for instance Application Pool Ratio or others). Each pool contains many
applications which are ready to be executed by the operator. For the list of minispec
standard applications listed above, there are suitable application programs in the
Application Pools that allow the user to run those standard applications. Only the droplet
size applications are currently protected via a license number mechanism (please contact
your local Bruker office for details).

Separate documents describing the various minispec Application Pools exist and can be
found on the minispec Software CD in the folder Documentation.

Use of the applications in the various Application Pools is described in the minispec
Application Manual — also located in the Documentation folder on the CD.
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7 The minispec Standard Windows

The minispec user interface provides access to all menu functions, parameters, application
programs, NMR signal display, and measurement results. In order to provide ready access
to commonly needed views of the software operations, the screen is divided into different
parts. To facilitate measurement handling and provide easy access to command
commands, icon bars have been integrated into the user interface, and windows are
available for the control of the measured signal (Signal Window) and the results (Result
Window, Statistics Box).
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Figure 7.1: The View of the Signal Window, Result Window and the Spread Sheet.

For the preconfiguration of measurements and a simplified data output a Spread sheet/
database Window is integrated in some applications. Furthermore, the interface layout is
adjusted to the individual needs of the analysis for most of the recent standard application
fields.

The functionality of the windows, i.e. the possibility to move them, depends on the
analyzer type you are working in. Repositioning of bars and windows is only allowed
for the Relaxation Time and the NMR-Analyzer.

71 The Signal Window

The Signal Window displays the measured NMR signal or the fit results graphically. In
some analyzer configurations (NMR and Relaxation configurations) the display can be
resized. Scaling of the data and the type of symbols used for the presentation of results
can be adjusted from the View pull-down menu, again depending on the analyzer type.
Data displayed in the Signal Windows can be saved to a file with the extension ‘.sig’ using
the command Save or Save Copy As from the pulldown menu File.

7.2 The Results Window

The Result Window is an output device for minispec applications that uses the ExpSpel
command print line (RESULTBOX, ...) to display a record of the evaluated result.
Results are printed in the Result Window in ASCII text format. The results can be stored
using the Save or Save Copy As... command from the pull-down menu File. Contents of
the Result Window are automatically saved at intervals to a file with extension .mdft). To
determine the parameters of the save procedure, use the command Save Setup in the
pull-down menu Save.
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Result files can also be read with a common text editor. One can select and copy the data
to the clipboard as ASCII text with the command Copy in the pull-down menu Edit. To
toggle between the normal and the large font result box, mark / unmark Large Font Result
Box from the View menu.

7.3 The Spreadsheet Window

Spreadsheets have a number of functions in the minispec software:

» They allow a clear data input for the preparation of a measurement series.
« They give a listed view of the measurement results.
* They allow the data to be saved and post processed in common file formats (like MS

ACCESS/EXCEL).
* A spreadsheet will be displayed automatically if it is implemented in the loaded
application.
7.31 Execution of Spreadsheets

Normally the tables are executed after RUN is selected, beginning from row one to the end
of the entries. But you can also measure single rows of the table by marking these lines
and then selecting RUN. This may be useful if not all samples are prepared at the
beginning of the analysis or if several measurements should be repeated.

7.3.2 Saving Spreadsheets

Spreadsheet data are saved automatically every time an entry is changed and any time the
ENTER key is pressed. The filename is generated by the minispec software:

<application>\MMMYY\DD\hh\mm\ss.mdb with:
<application>: path of the current application
MMM: month (Jan, Feb, Mar,..., Nov, Dec)

JJ: year (99, 00, 01, ...)

DD: day (01, 02, ..., 31)

hh: hour (00, 01, ...23)

mm: minute (00, 01, ..., 59)

ss: second (00, 01, ..., 59)

Saving in ASCII-format

The files can be saved alternatively in ASCIl-format by using the Save or Save Copy As
commands. The file name will be prompted in a standard file selector box, and the file
extension used is *.tab. The first row of the data includes the headlines of the spreadsheet,
the columns are spaced with a <TAB>. The ASCII tables can also be opened with standard
text editors like NOTEPAD/WORDPAD or MS-EXCEL.

7.3.3 Monitoring

During a measurement the spreadsheet is updated by the minispec software every time a
result is added. The tables can be opened on the measurement PC or any other PC
equipped with MS-ACCESS97. External monitoring of the measurement results via a
network connection is therefore possible.
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8 The minispec Menu Functions

The minispec software provides many opportunities for data display, data saving, and
measurement handling. This chapter describes all functions that are available when the
software is configured as NMR-Analyzer .

When the minispec is used only for specialized applications (SFC, OIL) many of these
functions are unnecessary. In this case, the number of menu options is reduced to simplify
the interface and make the software easier to use when the configuration is adjusted to
certain analyzer types. Commands whose functionality may be not reasonable in some
contexts appear grayed or may no longer be visible.

The actions of the functions are described below.

8.1 The Bars

The minispec software menu structure and toolbars are designed within the framework of
most standard Windows software to ensure intuitive handling (see the screen layout in the
figure below). In the Menu Bar actions can be selected via pull-down menus. Icons are
also used for commonly used actions and remain visible in the Standard Toolbar.
Depending on the options selected, the most important commands for the execution and
abortion of measurements may also be accessible through large icons on a Measurement
Toolbar, which is usually positioned at the bottom of the screen below the signal window.
In the Result Bar the numerical resuli(s) of the last measurement is displayed. The Info
Toolbar contains easily selectable buttons pertaining to the instrument status and
parameter display, as well as a list of loaded applications. Finally, the status of the
measurement and connections are summarized in the Status Bar. The functionality of
these items is described in the following sections in detail.

Adjustment of the bars (i.e. the possibility to move them) depends on the configuration of
analyzer type you are working in. Repositioning of bars and windows is only allowed for the
Relaxation Time and the NMR-Analyzer.
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Figure 8.1: The Default View
The arrangement of the different bars supports an intuitive measurement handling.

8.2 The File Menu

The list of items in the Menu Bar depends on the active window. If the Signal Window is
active, and an application is loaded, all entries are visible. The functions of the menu can
be activated by a mouse click, or alternatively, using a keyboard shortcut (Alt + underlined
letter).

|Ei|e Edit Minispec Measure Parameter View Process Window ﬂelpl

By activating the File menu all commands necessary for file handling are available (see
figure). Their use is in analogy to conventional Windows software, you can open, close,
save or print the contents of the selected windows (or the whole application).

Edit Minispec Measure Parameter
Open... Ctil+0
Close
Save Ctrl+S

Save Copy &s...

Print... Cul+P
Print Preview
Print Setup...

1 d\ppitransverse_decay.app
2t _ir_mb.app

3 transverse_decay.app

4 c\wnmscurr...\M2_demo.app
5 c:\wnmscur\...\t1_demo.app

Exit

Figure 8.2: The File Pull-Down Menu
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The Open Command
Shortcuts: Standard Tool Bar:
=
Keys: CTRL+O
Use this command to open an existing document in a new window.
One can select either:

* A complete minispec application (flename extension .app) consisting of maximum four
windows: an editor window with ASCII-text in ExpSpel programming language; the Signal
Window with the measured signals; the Result Box; and in some cases a spreadsheet.

* Measured signals (filename extension .sig) and measured data Result Boxes (file name
extension .mdft) separated from its minispec application.

+ Diagnostics files.

The Close Command
Use this command to close all windows in the active application or document.

If the focus is on one of the four views (windows) of a minispec application, the complete
minispec application with all views will be closed.

Shortcut: Standard Tool Bar:

X

If you want to close all applications use:
Shortcut: Standard Tool Bar:

A

The Save command (Save As, Save Copy As)

Use the Save command to save the active document to its current name and directory.
When you save a document for the first time, the minispec software displays the Save
Copy As dialog box for input of a name. If you want to change the name and directory of
an existing document before you save it, choose the Save Copy As command.

If you want to make a copy of an existing document, choose the Save Copy As...
command.

Shortcuts: Standard Tool Bar:

Keys: CTRL+S

The Save Setup Command

The Result box displays results derived from the NMR data (after evaluation steps defined
in the minispec application). Results are automatically saved as ASCII text at intervals (file
extension: .mdft ).

To set the parameters for the save procedure, select Save Setup from the result box file
menu:
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Settings Print Out in Results Header [~

Figure 8.3: The Dialog Box for Data Saving Setup

Select Default Storing to backup every 100 result box lines of measured data to the file
<application>.mdt in the current working directory.

When you attempt to exit the minispec application, the system will prompt whether the data
should be saved, deleted or copied into another file.

Select Don't Prompt Saving to deactivate the prompt when saving, in which case the
unsaved parts of the result box are then saved automatically. After reloading the minispec
application, the results will be erased before the first new results are outputted to the
Results box.

Select Automatic Storing for an automatic documentation of measured results.
The default path for saving is:

<current application directory>\<MMMJJ>\<ddhhmmss>.mdt

MMM: month

JJ: year

dd: day

hh: hour

mm: minute

ss: second

To modify the default path setting, select Browse... and define another folder. Default
saving is every 100 lines and when leaving of the minispec application.

You can modify the default data saving behavior using Measured Data Backup every....

To include an output of the instrument and acquisition parameter settings, select Settings
Print Out in Results Header. These settings are dependent on the minispec applications.

The Print Command

Use this command to print a document. It opens a Print Dialog Box, where you may
specify the range of pages to be printed, the number of copies, the destination printer, and
other printer setup options.

Shortcuts: Standard Tool Bar:

&

Keys: CTRL+P
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The Print Preview Command

Use this command to display the active document as it would appear when printed. The
main window will be replaced with a print preview window in which one or two pages will
be displayed in their print format. The Print Preview toolbar offers options to view either
one or two pages at a time, movement back and forth through the document, zoom in and
out of pages and to initiate a print job.

The Print Setup Command

Use this command to select a printer and a printer connection. This command presents a
Print Setup dialog box where the printer and its connection are specified.

The 1, 2, 3, 4, 5 Commands

Use the numbers and filenames listed at the bottom of the File menu to open the last five
documents you closed. Select the document you want to open.

The Exit Command

Use this command to end your minispec session. You can also use the Close command.
The minispec software prompts you to save documents when unsaved changes exist.

Shortcuts: Headline:

X

Keys: ALT+F4

8.3 The Edit Menu

The list of commands in the Edit pull-down menu depends on the active window (see
figure below). In the following description all commands are included to ensure a complete

documentation.
Minispec  Measure Paral
Urde (Strisz
Copy as Data Chrl+C Minispec  Measure  Pargy
Copy as Bitmap Ctil+B Copy Chrl+C
Delete Del Select All Clrl+d,
Select Al Cil+ Erae Al Del
Unselect &ll Ctrl+L) Find... Chil+F
v license Loplieater v [License Application
v License ‘ErpSpel v License ExpSpel

Figure 8.4: The Edit Pull-Down Menus for Different Active Windows

In the figure above, the left side shows the menu when the Signal Window is active, and
the right side when the Results Window is active.
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The Copy Command (Copy as Data, Copy as Bitmap)

Use this command to copy selected data into the clipboard. This command is not available
if no data is selected. In the case of signals, data are copied as x-, y- (, z-) data in ASCII
format, to allow an easy transfer to Excel. Use Copy as Bitmap from the Edit menu to
copy signals as bitmap to the clipboard.

Shortcut Keys: CTRL+B (Copy as Bitmap)
Shortcut Keys: CTRL+C (Copy as Data)

The Select All Command

Selects the entire content of the Result Window. In the Signal Window this command is
only valid in connection with calibrations.

Shortcut Keys: CTRL+A

The Unselect All Command

Unselects the entire content of the Result Window. In the Signal Window this command is
only valid in connection with calibrations.

Shortcut Keys: CTRL+U

The Erase All Command

Erases the entire content of the Result Window, without erasing the data from the
corresponding automatically saved measured data file.

Shortcut Keys: Del
The Find Command

Use this command for searching and highlighting words or text fragments.
Shortcut Keys: CTRL+F

8.4 The minispec Menu

All commands concerning instrument settings are included in this menu item. The
commands for the magnet heater calibration and the receiver tuning are only available for
BRUKER service personnel and therefore are grayed with a normal software startup. The
list of commands depends on the status of the instrument (see figure). If there is no
application loaded, the list is enlarged by the commands Connect and Disconnect.

the minispec

Instrument Settings

W aanett eater Ealbration
iire Hecever

Tune Settings

Update Settings

Daily Instrument Check

Balance Settings
170 Port Settings
Licenses

(Sonnect

Disconnect

Figure 8.5: The minispec Pull-Down Menu
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The Connect/Disconnect Command

Once the system requirements for TCP/IP have been fulfilled, a software link between the
minispec software running on a PC, and the minispec must be initialized. To establish the
PC to minispec connection, select minispec Connect. Alternatively you can select
Connect in the Welcome Box.

Enter the minispec Serial Number when prompted by the Connection Dialog Box.

The minispec Serial Number must be a valid entry in the MS-Windows ’hosts* file and have
the form 'NBxxxx' for NMS- or 'NDxxxx'/'NFxxxx' for mg-systems.

The minispec serial number, which is the host name of the minispec, is used to identify the
BRUKER minispec, controlled by the minispec software that is running on a PC in a TCP/
IP network. It is recommended to add the IP address of the minispec and its corresponding
Serial Number to the Windows ‘hosts' file on the PC, if not already done by the software in
the setup procedures described earlier (section Connecting the PC to the minispec for the

First Time [» 42] and Wake-up State of the minispec.exe Software [» 44]).
To add the IP address and the serial number of the minispec:

1. Open the file ‘hosts’ from the Windows folder (e.g. ‘notepad’).

» |n the case you work with Windows NT the hosts file is placed in the directory:
system32\drivers\etc\.

2. Add a line in the following form to the file: <IP address><Space><minispec Serial
Number> Where <IP address> is the network wide unique IP-address in the form
XXX XXX XXX. XXX, and <minispec Serial Number> is the minispec Serial Number of the
form ‘NBxxxx’, ‘NCxxxx’, ‘NDxxxx" or 'NFxxxx'.

Use the command Disconnect from the menu to disconnect from the current minispec
(e.g. prior to reconnecting to another minispec).

The Instrument Settings Command

Minispec instrument settings (see the figure below) are instrument dependent values such
as the pulse lengths and the magnetic field at NMR resonance. Instrument settings differ
from minispec to minispec, and must be tuned the first time a minispec is connected. You
can use this command to change the settings of the instrument with manual input.

the minispec Instrument Settings ml
| ~ND1428—
90° Pulse Length [us] |18 j % o Advanced... I

Puise Attenuation [dB] [0_::{
Det Angle (broad) ('] fnTj
Det. Angle fnanaw) 7] [118 ::]‘
Gain[d8) IT:]]
Recycle Delay 5] !2_j]
Magnetic Field Steps |20 ﬂ
Magn. Cycling Steps I”—j

180° Pulse Length [ps] |3,1 ::]‘ V' Electronic Unit Temperature Check

[V Sample Insertion Detection

Rec. Dead Time [ms] 0.007 ﬂ
Field Homog. Limit [ms] |0.5 ﬂ

Desired Magnet Temp. [C] [352 ﬂ i

- NMR Frequency
) 20MHz € 10MHE

|20000000 7] [+0000 ¥

Base Freq. [MHz]  Freq, Offset [kHz]|

SFC Settings...

Figure 8.6: The minispec Settings Table

You can change the listed settings by manual input or with the Update Settings and Daily

Check commands. Greyed entries are disabled.
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Shortcut: Standard Tool Bar:
ofE

The settings that can be changed are shown in the figure above. If the minispec Settings
are disabled on a connected minispec, customize your minispec software (through the
Welcome Box) to access the calibration parameters.

The Advanced button in the settings table allows access to a list of instrument setting
table names. The user may select the appropriate settings table to be used by the
instrument, define custom names for the settings tables with the help of the Customise
button (e.g. settings table name could be set to the probe name), and save the current
entries under a new name.

Entries in the settings table about SFC are only relevant in the case of the SFC-Analyzer. If
the SFC-item in the upper middle part of the settings table is marked, then the Update
Settings and the Daily Check routines will include steps to determine the SFC-specific
values. The factors (K, F, and O) and the sampling windows for a solid fat content analysis
are definable via the SFC-Settings button.

The Tune Settings Command

When the minispec is first connected to the PC, all instrument settings must be tuned
starting from default values. This can be done with the Tune Settings command. The
routine will tune all settings of the instrument without user prompting. If the Tune Settings
menu stays disabled on a connected minispec, customize your minispec-software to get
access to the calibration parameters.

The Update Settings Command

A blue mark (validated) symbol on the right side of the Info Toolbar indicates a well
checked minispec instrument.

v

Validated

An update of the instrument settings can be done periodically to check the instrument
validity. An update may be necessary after the system has been relocated or the probe
assembly has been changed. An instrument settings update is also recommended if the
Daily Check fails.

The Update Settings routine is faster than the Tune Settings routine, as it starts from
pre-adjusted settings (listed in the current instrument setting table). The Update Settings
routine also the update of selective settings, whereas the Tune Settings command will
tune all settings without further user prompting. For instrument optimization it is
recommended using the Update Settings routine. For the initial tuning of the settings, the
Tune Settings is the method of choice.

If the Update Settings menu stays disabled on a connected minispec, customize your
minispec software (through the Welcome Box) to provide access to the calibration
parameters.
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The Daily Check Command

This option tests the instrument tuning but does not change the instrument settings. A
quick check is recommended once a day (every 24 hours). A checkmark (Checked) in the
Info Toolbar signifies a well-checked minispec instrument. An un-calibrated minispec
instrument is indicated by a yellow mark (Check!).

Check!

To run the Daily Check, use the corresponding toolbar button or select Daily Check from
the menu. If one of the checks fails it indicates that an instrument setting is not optimized.
Use the Update Settings command to perform an update.

Shortcut: Info Toolbar:

Daily Check

The Balance Settings Command

One can connect a scale by serial interface to the PC's communication port in order to
electronically transfer sample weight information (weights are necessary for some absolute
applications). To enter the port configuration dialog, close all minispec applications, then
select Balance from the Setup menu. Access is limited to users who have permission to
enter the minispec main menu or calibration. Select the balance type, then the port to
connect the balance to. Select the port parameters according to the settings on the scale.
To set the standard values, click <Default> before leaving the Settings Table. To leave the
Settings Table unchanged, click <Cancel>. To re-load old settings from file after
modifications, click <Re-Read>. To leave the Settings Table with the new values, click
<OK>.

The I/0 Port Settings Command

One can connect serial interface devices, such as balances, thermostats or sample
changers, to the PC's communication port. To get the port configuration dialog, close all
minispec applications, then select 'l/O Port' from the 'Setup’ menu. Note: To get the
minispec main menu, the R&D level or calibration permission must be given. Select the
port parameters according to the settings on the connected device.

The Licenses Command

Some special applications, like the digital pulse attenuation and the pulse shaping need to
be licensed. Use this menu to open the license number input box, which prompts the user
to input the license number. After a successful license procedure, the menu entry is
checked and grayed.

Have ready the minispec instrument's system number (see Status Bar ) and contact
BRUKER for information or license numbers.
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8.5 The Measurement Menu

All commands concerning the execution of measurements are concentrated in this menu
item (see the figure below). Since these commands are used frequently, quick select
buttons are available in the Measurement Tool Bar and key short cuts exist to enhance
accessibility.

Parameter View F

Run Enter
[Eartiue Ese
Stap

Calibrate Sample  Alt+C
Detect Raw Signal Alt+S
Fun Repetitive Alt+R

Figure 8.7: The Measurement Pull-Down Menu

The Run, Stop and Continue Commands

The Run command starts a measurement. If the Sample Detector is set ON (see:
Instrument Settings Command) the measurement will be executed automatically with the
insertion of the sample.

Shortcuts: Standard Tool Bar:

Measurement Tool Bar:

-

Keys: ALT+M or ENTER
To interrupt a minispec measurement, use the Stop command.
Shortcuts: Standard Tool Bar:

D

Measurement Tool Bar:

Stop

The command Continue is used to leave an intermediate process in order to continue
running the minispec application (e.g. during a waiting time, a data acquisition or a fit
display).

Shortcuts: Standard Tool Bar:
a
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Measurement Tool Bar:

Continue

Keys: ESC

The Calibrate Command

A typical minispec application detects NMR signals of the sample and then calculates the
result from the NMR signal. In some cases, the result can be directly calculated from the
measured signal (e.g. a relaxation time). In other cases the minispec applications may use
a reference method and calibration line to determine a sample property (e.g. oil, water or
fat content) from the NMR signal. As a consequence, the NMR signal must first be
calibrated with respect to sample properties. Select Calibrate Sample from the
Measurement menu.

Shortcuts: Standard Tool Bar:

Measurement Tool Bar:

Calibrate

Keys: ALT+C

Running a minispec sample calibration leads the user through several steps. In most cases
some application specific values (see: The Application Parameter Table Command) need
to be defined.

To calibrate a minispec application, proceed as follows:
1. Prepare at least 3 samples of known content for measurement.

2. Perform test measurements with each calibration sample to adjust the acquisition
parameters from the Acquisition Parameter Table in the Parameter menu. Adjust the
receiver gain to the sample with the strongest signal.

3. Save the parameters and leave the parameter table.
4. Run the sample calibration and follow the prompts.

A flag in the Info Toolbar indicates a calibrated minispec application.

Calibrated

An uncalibrated minispec application is labeled with the following flag:

Calibrate!
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The Detect raw Signal Command

In some cases, for example to adjust the acquisition parameters, it might be helpful to
detect the signal without data processing. This command was implemented to execute only
the pulse sequence and acquisition without data processing or result output.

Shortcut: Keys: ALT+S

The Run Repetitive Command
With this command a measurement can be repeated several times at a regular interval.
Shortcut Keys: ALT+R

Select 'Repetitive Measurement Settings' from the Parameter menu to determine the
waiting time in seconds before a repetitive minispec measurement, the delay between two
successive repetitions, and the maximum number of repetitive measurements.

8.6 The Parameter Menu

All parameters for acquisitions, applications and repetitive measurements can be defined
with the assistance of the commands in this menu:

[FECNECE Yiew Process Window Help
Acquisition Parameter Table Alt+P
Application Configuration Table — Al+T

Acquisition Pre-Delay Time
Repetitive Measurement Settings

Figure 8.8: The Parameter Pull-Down Menu

8.6.1 The Acquisition Parameter Table Command

Acquisition parameters are application dependent values (for example receiver gain,
recycle delay and number of scans to accumulate) that help define data acquisition. These
values can be modified when a minispec is connected to the PC and a minispec
application has been loaded. To modify acquisition parameters open the Acquisition
Parameter Table.

Shortcuts: Standard Tool Bar:

S

Keys: ALT+P
To save the modifications to file, click <Save> before you leave the Parameter Table.

Note: Calibrated minispec applications will loose their calibration, if parameters are
changed.

If the Save button stays disabled on a connected minispec, customize your minispec
software to provide access to the calibrated application.

Experiment parameters that can be edited through the Acquisition Parameters menu:
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the minispec - PARAMETER DIALOG E

[OM LIMNE]

- o H
Scans: |5 j = :
Cancel |
AD [s] |1 ﬂ Default |
Save |

- Detection Mode:
2 d Imagnitude VI Help |

[ DOffset Compensation

Dummy Shots: |7 j A

 Broad & Mamow

Mag Cycl Steps: |0 ﬂ [20000 Digital [kHz]

Detect Raw Signal

E

Static Gradient [%]; |50 5l Tuiriz Giain

Figure 8.9: The Acquisition Parameter Table

Scans (1 - 32000)

Scans is used to set the number of times the NMR experiment should be repeated for
signal averaging before the result is evaluated. The required number of scans depends on
the signal strength, the desired signal-to-noise (which will limit the precision of the
measurement), and the desired speed of analysis (time between scans is set by the
Recycle Delay). Signal to noise improves with the square root of the number of scans. The
remaining number of scans during an experiment is shown in the lower right corner of the
display.

RD (seconds)

RD, or Recycle Delay, is used to set the time delay in seconds between repeated scans.
The recycle delay is usually set just a little longer than the relaxation time of the sample. If
the delay is deliberately made shorter than the sample relaxation time, one or more
dummy shots can be made prior to the experiments in order to ensure that the first scan
has the same history as all subsequent scans.

Gain (mg-Series ND systems: 40 — 119dB / for other systems the software will indicate the allowed
range)

Gain sets the signal amplification in the receiver. For best results, set the gain such that
the highest part of the signal reaches about 90% of the signal input range. For
measurements with a large gain (e.g. > 100 dB) the analog bandwidth should be set to
“narrow” to avoid saturating the input range with noise (not NF systems).

signals is too large for one gain setting, it may be better to have several calibrations for

n Note that the gain should not be changed for calibrated applications. If the range of input
different gain settings.
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Dummy Shots (0 - 32,000)

Pulses before the measurement can be made prior to the experiments (<Setup>
<Program> Menu), in order to ensure that the first scan gas the same history as all
subsequent scans.

Mag Cycle Steps (0 - 2048 Steps)

The Mag Cycle Steps provides a method of improving the performance of the detection
system for multi-scan measurements. Instead of accumulating all scans on resonance, the
magnetic field is cycled symmetrically about the resonance in steps, their size depending
on the field cycling range and the number of scans. For SFC measurements, a value of
500 steps gives good results. Setting the range to 0 disables field cycling.

Static Gradient (0 - 2048 Steps)

If a Pulse Gradient Unit is attached, this parameter is used to control a static gradient
generated with a constant current to the gradient coils. The static gradient reduces the line
width by spoiling the magnetic field homogeneity.

Detection mode (magnitude/real/imaginary/complex)

Sets the mode of signal detection. “Magnitude” detection calculates the root of the sum of
the squares of the real and imaginary parts of the signal, which are recorded by the
quadrature receiver. The “magnitude” mode is independent of the detection angle, and not
as sensitive to off-resonance effects of the magnetic field, but does not include any signed
information (i.e. is always positive). Data recorded in complex mode has a real and
imaginary component and can be Fourier Transformed for viewing in the frequency domain

(see The Process Menu [»_70]).

For applications requiring phase information (e.g. T1 relaxation), the in- and out-of-phase
components can be measured separately using the “real” and “imaginary” modes
respectively. If the detection angle and the magnetic field have been adjusted optimally,
the real component will be at maximum and the imaginary component will be zero.

Analog Bandwidth (broad/narrow)

The Analog Bandwidth is used to set the receiver bandwidth. The “broad” (1 MHz) setting
is used for measurements with rapidly decaying FIDs, which require minimum dead time.
The “narrow” (300 kHz) setting is used for measurements with weak signals which require
a high receiver gain.

NF systems are equipped with a full digital filter as known from high-resolution NMR,
therefore NF units no longer use analog filters.

Digital Bandwidth (1-20000 kHz)

The Digital Bandwidth is used to set a digital filter which acts in addition to the analog
bandwidth. If the digital bandwidth is higher than the current analog bandwidth (see
above), it has no effect. If it is set to maximum (20000 kHz), the digital filtering algorithm is
not carried out. For very weak and noisy signals, the digital bandwidth should be set as low
as possible without distorting the signal shape.

NF systems come with a real digital filter which means that the dwell time is related to the
setting of the digital filter. Changing the digital filter from the standard value in the
application software may lead to non-sense NMR signals. Make sure the relation between
digital filter and dwell is understood and set accordingly.
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8.6.2

The Application Configuration Table Command

8.6.3

The most common minispec applications can be configured for the special requirements of
the current measurement (e.g. whether the liquid or solid fat content has to be
determined). The command opens a table where the application options can easily be

edited.

Shortcuts: Standard Tool Bar:

Keys: ALT+P

The Application Configuration Table is optional, not all minispec applications need a
sample calibration or configuration, thus the configuration table may not be available for

these applications.

The Acquisition Pre-Delay Time command

8.6.4

In some cases a defined delay is desired between the time a sample is inserted and the
time of measurement start (e.g. if time is needed to allow the temperature of the sample to
equilibrate in the magnet). The Acquisition Pre-Delay Time command allows such a
delay to be set. The waiting time is added to the recycle delay of the first scan of the data
acquisition. Once a measurement is triggered, you can override the acquisition pre-delay
and continue with data acquisition by selecting the Continue command.

The Repetitive Measurement Settings Command

8.7

Repetitive measurements require several control parameters. When this command is
selected, a table appears where the following parameters can be specified: the waiting
time in seconds before a repetitive minispec measurement begins, the delay between two
successive repetitions, and the maximum number of repetitive measurements.

The View Menu

Each user can configure the screen for the special requirements of a measurement. With
the help of the pull-down menu View one can adjust the arrangement of the different
windows, the display of toolbars, the font size for the result output and much more. The list
of available commands depends on the active window and the active application (see

figure).

View Default  Al+Y
Toolbars

Info Views »
Display Modes >
Display Scaling »
Display Cursor »

v Welcome Box

VT ExpSpel Window Help
View Default

Window Help

Window Help
View Default

Al

Al View Default Al
Toolbars > Toolbars
Info Views » Info Views
v Welcome Box v Welcome Box
Pulse Ram Diagnostics Large Font Resultbox

Toolbars

Minispec System Status

v Diagnostics Yiew
Conpnection Diagnostics
Commands Diagnostics
Suppress Status Diagnostics

v Welcome Box

Figure 8.10: The View Pull-Down Menu

The View Default and the Toolbars Commands

The minispec software shows four tool bars: the Standard Tool Bar, the Result Bar, the
Measurement Tool Bar and the Info Tool Bar (see the figure above). When the minispec
software is configured as the Relaxation Time or NMR Analyzer type, all toolbars are
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docking toolbars. This means that the toolbars can be moved to any location on the entire
screen by pressing and holding the left mouse key. The location can be outside of the
minispec software main window, within the main window docked (e.g. on the left, right, top
or bottom), or switched off entirely. To switch toolbars on and off, mark/unmark the
corresponding toolbar in the minispec application menu View.

To get an impression of the toolbars and to restore the default screen select View Default.
Shortcut Keys: ALT+V

The Info Views Command
This command is subdivided into four parts:

1. minispec Settings: If you choose this item you will get a table of all minispec application
relevant instrument settings and parameters. Shortcut: Info Toolbar:

The function is disabled (grayed) if no minispec is connected.

View T -
Settings @

2. minispec System Status: The user can get a real-time indication of the status of the
minispec instrument, particularly:

— Magnet Unit temperature and status.
— Sample orifice status (sample inserted or not).

— Sample insertion detection (grayed if sample detection is set OFF (see: The Settings
Command)

— Transmitter power status.
— Heater power status.

— Electronic Control Unit temperature status (grayed if Control Unit temperature
detection is set OFF (see: The Settings command).

— External Gradient Unit status.
— Possibility of attenuated and shaped pulses.

The entries are marked with a checkmark () when the corresponding item status is OK.
Shortcut: Info Tool Bar:

Instrument @
Status
3. Results Mean. This function displays the Statistics Box (see figure), a window which

allows general monitoring of measurement results. The Statistics Box contains:

— mean value

— standard deviation

— current data value

— total number of data

— maximum value

— minimum value

— difference between minimum and maximum value
— graphic representation (Statistics “Meter”)
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The window can be minimized with the double arrow in the upper right part of the box (see
figure). Only the graphic view will be displayed in the minimized form. The green area in
the graph displays the range of tolerance for the measurement, the vertical lines through
the meter indicate the actual values, and the continuous broad vertical line represents the

mean value.
fid - STATISTICS x|
L
«
—DATA
Count: 24
Value: 85916 %
M aximum: 86.026 %
Minimum: ey et |
Delta: 0.165% Close I
—STATISTICS
Mean Value: 85.954 %
Standard Deviation: 0.045%
~LIMITS
Lower Limit |35«7 Upper Limit: |88.4 0K I

Figure 8.11: The Statistics Box

4. Fit Info: You can display a window containing all information of a current fit. An active Fit
Window is marked with a check mark.

The Display Modes Command
Different display modes are available for the measurement signal. Possible modes are:

L
1

ot t (o)
Lines Dots Crosses Circles Crosses Circles Histogram
& Lines & Lines

Figure 8.12: Display Modes
You can activate the desired display mode with a mouse click.
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The Display Scaling and the Display Cursor Commands

There are various possibilities for the data and cursor display. With these commands the
scaling of the Signal Window and the options for the cursor displays are adjusted. For easy
handling the commands can be executed using short cuts. The following display
operations are available:

k2
Resets the display to the default view.
Adds a grid to the signal display.

g

Toggles between separate or overlapping displays of real and imaginary signals.

18

Toggles between Full Scale (the limits are the highest and lowest values to be displayed)
and normal (100%) signal scale.

&
Zoom Scale on / off. To zoom, mark the signal with the rectangle cursor. Using the left
mouse button you can toggle between the left/upper and the right/lower limit. The zoom

range is defined using the right mouse button. To reset, use the right mouse button or click
the Reset button.

LA

Fix Scale on / off. Fixes the display scale (e.g. after zooming) and the display type if used
before a measurement.

Er

Data Cursor on / off. Allows the data cursor to be moved with the mouse or cursor keys.
When activated, data point information is available in the Status Bar.

&

Distance Cursor on / off. Allow the mouse or cursor keys to be used to position the
distance cursors. Use the left mouse button to toggle between the left and right distance
cursor. Data points distance information can be found in the Status Bar.

it

Marker Cursor on / off. Use the mouse or the cursor keys to position the data cursor. You
can observe data point information (and the distance from the fitted value) in the Status
Bar. The field is only active if a calibrated data file for the application exists.

Note: Zooming, data, distance and marker cursors can only be used exclusively.

68



The minispec Menu Functions

The Welcome Box Command

On the BRUKER minispec program start, the software wakes up with the Welcome Box
(see also section Configuration of the Software, the Welcome Box ['_44]). The Welcome
Box offers the possibility to adapt some software settings to the user’s purposes (e.g.
selecting a minispec application or connecting a minispec). To switch off the Welcome
Box, uncheck Display this Window on Startup in the Welcome Box. On restarting
BRUKER minispec software, the last minispec connection and minispec applications will
be reloaded automatically. One can deselect loading the minispec application after
program start via switching off the option Load Application on Startup in the Welcome
Box. You can also switch on / off the Welcome Box by marking / unmarking the Welcome
Box command in the View menu.

The Large Font Result Box Command

The information in the Result Window can be displayed using two different font sizes.
Marking this entry you will choose the larger font.

The Diagnostics View Command

With this command a window is opened up which displays various information for
diagnostic purposes. These options are helpful for checking the instrument status,
connections, and commands. Different diagnostics are available, depending on the active
window. The transfer of the diagnostic information from the minispec to the PC, and the
display in the Diagnostics View needs time and system resources, thus this command can
be used to regulate performance as required.

Note: To ensure a failure-free operation use these options only for diagnostic purposes
and not in the background for standard measurements. Unmark Diagnostics View and all
diagnostic possibilities when they are not any longer required!

The Pulse Ram Diagnostics Command

This command is only available if the Editor Window is active. If you mark this command,
information is printed about the pulse pattern of the NMR pulse sequence into the
Diagnostics View.

The Connection, Commands and Suppress Status Diagnostics Commands

If Connection Diagnostics is marked, information will be printed about the connection
between the minispec software and the minispec connected. With Commands
Diagnostics, information will be printed about the data exchange into the Diagnostics
View. Some status information about the hardware is requested every second. These
requests take also place if the status has not changed during the last interval. For a clear
and easy diagnostic it may be useful to suppress the printing using the command

Suppress Status Diagnostics.
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8.8 The Process Menu

The Process item is only displayed when a Signal Window is active. Different commands
for data processing are summarized in this pull-down menu:

Fit

EFT
Magnitude
Power
Absolute
Flip

Swap

Figure 8.13: The Process Pull-Down Menu

Within the context not all commands may be reasonable, in which case they will be grayed.
The following series of built-in signal processing features are available:

The Fit Command

This command is only available in connection with calibrations. You can fit your calibration
data and display the fit results (see Info Views, point 4).

The FFT, Magnitude, Power and Absolute Commands

A Fast Fourier Transform of measurement data will be performed using the FFT command.
If the NMR signal is observed in complex mode (real and imaginary part of the signal) the
Magnitude ([Re2+Im2]1/2) or the power spectrum can be calculated. From the real,
imaginary or complex data, the Absolute values can be calculated.

The Signal Flip, and the Signal Swap Command

The signal can be mirrored with respect to an offset frequency of 0 using the Signal Flip
command. The Signal Swap command exchanges the real and imaginary part.
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8.9 The Window Menu

.I'L"'II | 1! lj oW

Default At

Cascade

Tile Horizontally
Tile Vertically
Arrange lcons
Marker

1 81 _ir_mb.app
2 H1_ir_mb.mdt
3t _ir_mb.sig

Figure 8.14: The Window Pull-Down Menu

Default, Cascade, Tile Horizontal and Tile Vertical Commands

You can arrange the windows (see figure) as Cascade in an overlapping fashion, or you
may arrange multiple open windows Horizontally or Vertically side by side. To reset the
window alignment, use the Default command.

Shortcut Keys: ALT+W.

The Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main
window. If there is an open document window at the bottom of the main window, some or
all of the icons may not be visible because they are hidden behind this document window.

The Marker Command

This command sets the Marker Cursor on / off. Use the mouse or the cursor keys to
position the data cursor. Data point information (and the distance from the fitted value) is
then available in the Status Bar. The window is only active if a calibrated data file for the
application exists.

Shortcut Standard Tool Bar:

it

The 1, 2, 3,... Commands

Use the numbers or the mouse to select one of the listed windows at the bottom of the
menu to set it into the foreground.
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8.10 The Help Menu

For a user friendly handling the minispec software includes a detailed help function. You
have the choice of different entries to receive help on your questions (see figure). Green
entries in the help text are cross references to related topics. One may switch to them by
clicking on the green text.

Using Help
Help Topics

About the minispec...

Figure 8.15: The Help Pull-Down Menu

The Using Help Command

A help box will be activated with information on how to use the different help options.

The Help Topics Command

This command will open up a dialog box where the topics you want information about are
entered.

The About the minispec Command
Use this command to display the copyright notice and version number of your copy of the
minispec software.

Shortcuts: Standard Button Bar: i

Additional Help Functions

While moving the cursor through the buttons, a short on-line help will be displayed
describing the function of the button. At the same time a more detailed description is
displayed in the left part of the Status Bar.

If you want an expatiated comment about menu functions, windows, commands or buttons
use the Context Help command.

Shortcuts: Standard Button Bar: ﬁ
Keys: SHIFT+F1

When you select the Standard Toolbar's context help button, the mouse pointer will
change to an arrow and a question mark. Click somewhere in the minispec software
window, for example on another Toolbar button or a menu entry, to display the
corresponding help topic.

You can also receive help about the current active window. If you want to open a window
with detailed information use the shortcut keys F1.
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9 The Experiment Editor ExpSpel
for the mg-Series

The macro programming language ExpSpel was developed to allow the user to design
their own experiments and to modify the BRUKER standard applications. In the mqg-series
a large variety of new commands have been implemented to enlarge the number of
experiments. Important tools defined in ExpSpel are:

* Pulse sequences

loops, conditional jumps, flags, ...

acquisition parameters

time and wait functions

RF-pulse attenuation

shaped RF-pulses and gradients
» Data acquisition
— acquisition time
— acquisition points
— acquisition modus
» Data processing
— signal display
— measured data information
— fit routines
- FFT
» Data In/Output
— implementation of Spread sheets
— definition of file formats
 Calibration procedures
* Instrument settings
» Control of peripherals

In order to use ExpSpel, a license is required (only available in R & D levels). The license
number must be entered when prompted when the PC is connected to the minispec for the
first time. Alternatively, you can select Licenses from the minispec pull down menu and
enter the license number when prompted.

To open the editor window use the L& button. The Menu Bar changes, an additional item —
ExpSpel(] is displayed. This pull-down menu allows an application to be loaded, a spell
check to be made (short cut: [&) and applications to be translated. A translation can be
performed by loading the file into ExpSpel and clicking the Translate command in the
ExpSpel pull-down menu. To minimize the editor window click the button. The
experiment editor works much like conventional editors. Use the Edit pull-down menu to
access copy, paste and other actions. Usually the files are saved with the extension: ‘.app’.
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For a detailed description of ExpSpel refer to the extended Help file where all accessible
commands and actions are described in detail. Help Topics can be accessed from the Help
pull down menu. When the item About: ExpSpel is selected, an overview of ExpSpel is
displayed in the index.

When inspecting an ExpSpel sequence, it is also possible to highlight a command of
interest and press "F1" to immediately receive instructions about this command.
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10 Basic NMR Principles

NMR (Nuclear Magnetic Resonance) is made possible by the properties possessed by
some atoms that cause their nuclei (part of every atom) to have a magnetic moment. The
atom most commonly investigated by NMR is Hydrogen ('H), the nucleus of which is
composed of a single proton. Hydrogen is present in many natural and synthetic
substances like oil, water, polymers, pharmaceutics and foodstuffs. In a strong external
magnetic field (called polarizing field) produced by the permanent magnets in the Magnet
Unit, the magnetic moments can be oriented, and the vector sum of all moments results in
a macroscopic magnetization. The amount of magnetization depends on the strength of
the external magnetic field and the temperature.

Pulses of radio frequency (RF) at a suitable frequency can influence the magnetization in
the sample. In NMR this resonance frequency, called Larmor frequency, depends on the
field strength of the external magnetic field and the nucleus investigated. For example, at a
field strength of 0.47 Tesla, protons ('H) have a resonance frequency of 20 MHz. The
orientation of the magnetic field generated by the RF pulse is perpendicular to the static
external polarizing field.

When, for example, a sample containing NMR-active nuclei is exposed to a strong external
magnetic field by inserting a sample into the sample orifice of the magnet, the process of
build up of macroscopic magnetization will start immediately, but it takes some time until
the equilibrium is reached. The time constant of this built-up process is called longitudinal
relaxation time T, (see figure).

. 250 500 750 .1l]llll‘ 1250 1500 1750 ”[llmelnllc]

Figure 10.1: Increase of the NMR Signal Due to Longitudinal Relaxation

With skillful sequences of RF-pulses (generated by the Electronic Control Unit and
transmitted to the sample via the probe) the macroscopic magnetization can be influenced.
One possibility is the generation of so-called transverse magnetization. This is not an
equilibrium state, and therefore different relaxation processes arise. The transverse
magnetization is still the vector sum of discrete atomic magnetic moments. Each one of
these moments underlies a specific time evolution, and a loss of phase coherence results.
The time scale of this magnetization loss is described by the transverse relaxation time T,
(see figure) in the easiest case.
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Figure 10.2: Decay of the NMR Signal Due to Transverse Relaxation

Secondly, the system naturally tends to relax back to the thermal equilibrium. This process
is equivalent to the polarization process described above and takes place with the time
constant T,. Various other processes are known from NMR-theory, depending on the pulse
sequences used to manipulate the magnetization. These processes are described by
different relaxation times, some examples are T,,, T,p, and Te.

Substances and materials can be characterized by relaxation measurements because the
relaxation times are highly sensitive to molecular properties. For example, they can be
sensors for various ranges of molecular motions. The large range of motions that can be
characterized by NMR is a main point which makes NMR to such a valuable tool in
analysis. For example, because of their different relaxation behavior solid and liquid parts
in one sample can be distinguished clearly and their amount determined as in solid fat
content (SFC) measurements. As a consequence such materials as foodstuff, cosmetics,
chemical products and much more can be investigated. For a more detailed description
refer to the application descriptions available from Bruker.

Furthermore, the intensity of the NMR signal is a function of the number of atomic
moments contributing to the macroscopic magnetization. Therefore, the signal is a
measure of the number of nuclei in a sample. Minispec methods make use of this
relationship to determine the amount of, for example, oil or moisture in a wide range of
samples.

In summary, NMR makes use of the nuclei in substances as sensors of their surroundings,
yielding important information about the matter. Since both excitation and detection are
performed via electromagnetic waves in the radio frequency region, this analytical method
is contactless, non-destructive, and rapid.
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11 Maintenance

111 Cleaning

Before Cleaning

Disconnect the mains cable from the unit and remove all cables to the touch display before
cleaning.

Cleaning the Main Unit

Use a clean damp cloth to wipe off any residue from the outside of the unit. Wipe off
excess moisture immediately with a dry cloth.

For non water soluble marks, wipe using a cloth with a few drops of isopropyl alcohol.

Cleaning the Touch Display

The touch display can be cleaned by wiping it with a damp (not wet) cloth or with isopropyl
alchohol.

Before Reconnecting the Power Supply

Wait until the unit is completely dry before reconnecting the power supply and touch
display cables!
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12 Dismantling and Disposal

Following the end of its operational life, the unit can be returned to Bruker for safe
disposal. If this is impractical, the unit should be disposed of safely as prescribed by local
environmental regulations.

device must only be carried out by Bruker Service or personnel authorized by Bruker.

n Installation, initial commissioning, retrofitting, repairs, adjustments or dismantling of the
Damage due to servicing that is not authorized by Bruker is not covered by your warranty.

12.1 Dismantling

Before starting dismantling:
1. Shut down the device and secure to prevent restarting.
2. Physically disconnect the power supply from the device; discharge stored residual energy.

3. Remove consumables, auxiliary materials and other processing materials and dispose of
in accordance with the environmental regulations.

4. Clean assemblies and parts properly and dismantle in compliance with applicable local
occupational safety and environmental protection regulations.

12.2 Disposal

If no return or disposal agreement has been made, send the dismantled components for
recycling as prescribed by local environmental regulations.

» Scrap metals.
« Send plastic elements for recycling.

» Dispose of packaging material in accordance with the relevant applicable legal
requirements and local regulations.

» Sort and dispose of other components in accordance with their material composition.

NOTICE

Danger to the environment from incorrect handling of pollutants!

Incorrect handling of pollutants, particularly incorrect waste disposal, may cause
serious damage to the environment.

1. Always observe local environmental regulations regarding handling and disposal
of pollutants.

2. Take the appropriate actions immediately if pollutants escape accidentally into the
environment. If in doubt, inform the responsible municipal authorities about the
damage and ask about the appropriate actions to be taken.
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13 Contact

Manufacturer:
Bruker BioSpin CMR
Am Silberstreifen
D-76287 Rheinstetten
Germany
Phone: +49 721-5161-6141
http://www.bruker.com

NMR Hotlines
Contact our CMR service centers.

Bruker provides dedicated hotlines and service centers, so that our specialists can respond
as quickly as possible to all your service requests, applications questions, software or
technical needs.

Please select the Bruker CMR service center or hotline you wish to contact from our list
available at:

http://www.bruker.com/service/information-communication/helpdesk/magnetic-
resonance.htmi
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